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Setting Up a Rhino Model for Daylight Analysis 
The following includes information about proper set-up of the Rhino model for use with the toolbar. To make 
sure that all geometry is being used in the analysis, it is a good idea to first run the “Visualization” Metric, and 
to examine the image for unexpected problems such as “holes” or gaps. 
 

Units 
It does not matter what units are used for the Rhino modeling: meters, millimeters, inches, feet, parsecs, etc. 
  
Orientation 
It is important that your project is oriented properly within Rhino with regards to North. In Rhino, as most other 
software, North is the top of the screen when viewing the model in a “Top” or “Plan” view such that the positive 
Y-axis is North. 
  
Layers 
DIVA does not require any specific naming conventions for layers; however, materials will be associated by 
layer, so you can't keep geometry with different materials on the same layer. 
  

 
Layer panel showing DIVA-Created Layers 

 
DIVA Layers 
When you run the DIVA Location button, several DIVA layers are created. These layers store the various 
nodes, node values, grid and legend information that DIVA generates. 
 
Hidden Layers 
Layers turned off will not be exported. 



 
Locked Layers 
Locked layers will not be exported. 
 
Sublayers 
There are no restrictions to using sublayers. 
 
Ground Plane 
A ground plane should always be modeled and assigned a DIVA material. 
 
Geometry 
Models can be built using surfaces, polysurfaces and/or meshes, although all geometry is "invisibly" converted 
to temporary meshes through the DIVA process. Complicated geometry can be "pre-meshed" before running 
the metrics. 
 
Thickness 
Glass should be modeled using single surfaces, as opposed to polysurfaces or solids. 
 
Visibility, Locking and Hiding Layers 
Only geometry on visible, unlocked layers will be exported to Radiance. Keep this in mind when running 
simulations. 
Remember to always check that your geometry is being exported correctly by running the “Visualization” Metric 
and performing a visual check. 
 

File Naming in DIVA 
You are free to name your Rhino file whatever you like, and store it wherever you like on your computer. When 
you run DIVA, a results folder is created which stores all of your results files. This folder is created in the same 
folder that your Rhino file is stored, and is given the name of your Rhino file plus " - results". For example, say 
you name your file: My House.3dm, and you keep the file in C:\Users\yourname\Documents\RhinoModels. 
 When you run DIVA, a results file will be created in that folder 
called: C:\Users\kera\Documents\RhinoModels\My House - DIVA\.  

 
Contents of the results folder that DIVA creates for each Rhino file   

 
 
 
As part of the process of using the toolbar, a folder is created in which necessary auxiliary files are kept. These 
supplemental files are located in, C:\DIVA\Temp\. In this example, they would be stored in C:\DIVA\Temp\My 
 
Important! Spaces in your file name 
You will notice that in the Temp folder, the entire name of the example file is not preserved. This is because 
there is a SPACE in the Rhino file name. This does not affect anything EXCEPT, if you were to run DIVA on 



another file (anywhere on your computer) called, say, My Dogs House.3dm, the original files in the Temp 
folder will be overwritten causing potential problems the next time you go to run a DIVA simulation in the My 
House.3dm file.  
 
If you want to avoid any potential issues, simply do not use spaces when naming your Rhino files if you are 
going to use DIVA. 
 

The DIVA User Interface 

The Toolbar 
After following the instructions in Installation, the DIVA toolbar will be visible within Rhinoceros. The toolbar 
contains four buttons: Location, Nodes, Materials, and Metrics.  
  

The four buttons of the DIVA 2.0 toolbar 
 
These buttons are primarily designed to be used in order from left to right to run daylight and energy 
simulations. Several of the DIVA toolbar buttons have two functions: one is accessed by a mouse left click and 
the other via a mouse right click. In essence, there is no “Undo” for the buttons. If you have made a mistake, or 
you wish to change any option, simply press the appropriate button and change the settings.  
 
 
Location 
The “Project Info” button has two functions. The first is similar to “New File” or “Save As” in other programs. It 
sets up a folder and a naming convention for results files. The second function is to establish the latitude, 
longitude and timezone of a project by associating it with a climate (.epw) file. For climate-based simulations 
and radiation maps, the hourly solar insolation is also read from the EPW file. 
 
The Boston climate file is loaded with the DIVA plug-in into the folder C:\DIVA\WeatherData. There are a 
plentiful amount of free EPW files available for download from the US Department of Energy's Website. Save 
these files to the same C:\DIVA\WeatherData directory.  
 
 
Nodes 
The sensor nodes are the points at which the light levels are calculated.  
 
 

 
Nodes button 

 
Left-clicking on the button sets up an analysis grid for any nodes-based simulations in DIVA. The nodes array 
size, location and orientation are based on a piece of geometry from your model that you select. This can be a 
floor, wall, or any other surface, or multiple surfaces, and can be in any orientation (horizontal vertical, at an 
angle, etc.). 
 
 
Surface Normals 
The normal direction of the surface determines the orientation of the sensors. This is visualized by the direction 
the nodes are offset from the surface. If the point objects appear below the analysis surface, the normal of the 
surface should be flipped and the above process followed again. The 'Dir' command in Rhino can be used to 
visualize and flip surface normals. 



 
 
Node Offset and Spacing 
Typically, the sensor nodes are offset a specified distance off of the selected surface, and a specified distance 
apart. DIVA will prompt you to select these values, and suggests default values. Those values are always 
shown in the current model units. This can be feet, inches, meters, etc. 
 
Tip: For typical workplane simulations, the sensor grid is set 30" off the floor and the nodes are no more than 
36 " apart. 
 
Nodes and the Test Surfaces layer 
The "Test Surfaces" DIVA sublayer is a helpful place to store a reference surface if that surface does not exist 
as part of your built geometry. For instance, if you want to test only part of the floor or wall, you can make a 
surface on the "Test Surfaces" layer which is the size of the area you want to focus on. 
 
 
Materials 
Materials must be assigned to the project geometry in order for it to be analyzed for daylight or energy 
performance. 
 
 

Materials button sub-menu 
 

 
 
Once your project location and sensor grid is established, Radiance materials must be applied to layers in the 
Rhino model. Each layer that the user wants to include in the simulation needs to have a material associated 
with it. To assign materials, use the Materials button and the "Assign Materials" option. A small library of useful 
materials is included with DIVA, and will show up as options in the pull-down menus. 



Materials Menu 
 
 
 
 
Custom Materials 
Note that customized Radiance materials can be added to the material choices. See the page, Custom 
Radiance Materials for more information. By default, DIVA instantiates each project with the default materials 
file, located inC:\DIVA\Daylight\material.rad. Project-specific materials can be defined in 
the .\ProjectName - DIVA\Resources\material.rad file. The ProjectName - DIVA directory is 
located in the same folder as your Rhino file. 
  

The materials menu has two tabs: Daylight Materials and Thermal Materials. Use the one appropriate for the 
simulations you will be running, or both you are running both. 

Metrics 
 
 

 
Metrics button 

 
The Metrics button has two functions. Left-clicking the button brings up the dialog box that allows the user to 
run the various simulations. Right-clicking on the button allows the user to load in previous simulation data. 
The dialog box displays different information for each simulation type, but generally allows you to set things 
like: simulation type, quality or "resolution" of simulation, sky condition, date and time or schedule, lighting 



units, image size, image output and image viewer.  
 
The Radiance parameters are automatically set, however, there is always a text-editable box where you can 
edit your own Radiance parameters. Before doing so however, you should read carefully the Radiance 
documentation to learn more about the commands and their values. 
 

Your First Simulation 

These steps will lead you through your first simulation. We will be running an illuminance test using a simple 
classroom model. You can download the example Rhino model here. When you open the file, you will see a 
large building shell, with a single classroom modeled on the first floor. The file also contains several named 
views. 
  
Step 1: Selecting the project location 
The first step is to determine where the project is located using the Location button. 
 
 
1. Left click on the Location button. 
2. Follow the prompt and select the Boston climate file. 
 
 

Select project location 
 
 
Step 2: Setting up the sensor nodes 
We are conducting a simple illuminance test at workplane height. The sensor nodes will be arrayed 
horizontally, with their orientation vector pointing up, so in this case we want to select the floor as the drive 
surface for the nodes. 
 
 



Nodes will be offset in the direction of the surface normal. To check this, in Rhino, type "Dir" for "Direction", 
and select the surfaces you will be applying nodes to. This command will allow you to view the normals of the 
selected surfaces. If any are oriented in the wrong direction, click on them while the command is still active in 
order to flip the normal.  
 
 
1. To start, left-click on the Nodes button. 
2. Select one or more planar surfaces which will serve as the base planes for creating the sensor nodes. The 
surfaces do not have to be parallel and can be in any orientation (horizontal, vertical, etc.), but they must be 
planar (i.e. no curved surfaces). For this example, select the floor surface, and press Enter.  
 
 

 

Setting up sensor 
nodes 

 
 

 
3. The Rhino Command Line prompt will ask for the distance of sampling nodes off of analysis surfaces. 
Accept the default (30") by pressing Enter. This will put our sensor nodes 30" off of the floor, roughly at desk 
height. Enter distance of nodes off of that surface. 
  



 
 
 
4. The Command Line prompt will ask you to enter the approximate square edge length of the grid dimensions. 
The edge length means the spacing between grid nodes. 
Accept the default (15"). This will set the nodes roughly 15" from each other in both directions. 

 
 

Enter the grid 
density as a distance between sensor nodes. 

Check that the 
points are on the right side of the surface. 

Here the points are inside the space, so all is fine. 
 
Step 3: Setting Materials 
Materials are associated with geometry by layer. It is important to note that any geometry on a layer withouta 
material applied, will not be included in the analysis. 
1. Left click on the Materials button. A dialog will pop up which reads all materials from the DIVA materials file. 
2. Select the materials as shown below. 
3. Click Submit Material Information. 



 An example of the materials window. 
For more information on materials check out custom materials. 

 
 
Step 4: Running your first visualization 
It is always a good idea to run a visualization first in order to verify that all of the geometry is being properly 
exported during the analysis. 
  
1. In Rhino, set your viewport to the named view, "view_room". 
2. Left click on the Metrics button 
3. Select the Daylight Images Tab, then the Visualization Tab 
4. Accept all of the other defaults, and click Run Simulation 



 
Daylight images - visualization menu 

 
First, a DOS window will pop up, and after a short period of time, wxfalscolor will launch and display the 
rendering of the model.Your visualization should look similarly to the following image. 
  



For more information, 
see visualizations. 

 
 
Step 5: Running your first metric 
We are now ready to run the illuminance test. 
  
1. Left click on the Metrics button 
2. Select Daylight Grid Based 
3. Select Point-in-Time Illuminance 
4. Leave all of the defaults, and click Run Simulation 



 Point-in-Time Illuminance menu 
 
5. Another DOS window will pop up, and this time, it may take slightly longer to run. 
6. When the simulation is complete the "Load Metrics" dialog box will appear. 
Here is where you can select a variety of display options including the upper and lower bounds of the results, 
whether or not to display peak values or a variant label. You can also choose to change the display colors or 
node values. Don't worry if you change your mind about the options that you select. You can always change 
your options by right clicking on the Metrics button and reloading the data. 
7. For now, Leave all of the defaults, and click Load Simulation Data. 
8. Turn off the ceiling and outside facade layers, set your view to Top and for a sharper display, set your view 
to Shaded. Zoom out until you can see both the room and the legend.Your results should look something like 
below. 
 



Congratulations! You have completed an analysis with DIVA. 
 
 

Step 6: Results and Reports 
Legend 
The legend includes valuable information about the conditions under which the analysis was run, as well as 
important result statistics. The false-color grids are grouped into "panelgroups". There is one panelgroup per 
surface selected during the nodes creation step. If you aren't sure which panelgroup is which, in Rhino, use the 
"SelGroup" command, and enter "panelgroupXX" where "XX" represents the group number you are looking to 
identify. This will highlight the associated false-color grid. 
 
False-color grid 
The upper and lower bounds of the analysis are controlled by your selections in the "Load Metrics" dialog box. 
If you want to change the bounds, or any other aspect of the results display such as the display colors, whether 
node values are displayed, or other variants, simply right click on the Metrics button. You can load the analysis 
that you just performed and select the desired options, or you can load any other tests that were performed 
using this model. 
  

Tips: 
A. The legend scale and the flase-color grid are both mesh geometries. In the "Options" menu of Rhino, you 
can change the way meshes, particularly mesh edges are displayed. Reducing the mesh edge thickness to "0" 
will eliminate the border on the meshes, creating a smoother look. 
B. To create consistent reports, use the Layout and Detail commands in Rhino to create page layouts. 



 
 
Step 7: Reloading Results 
For practice, let's try changing the way our results are displayed. To do so, we will "reload" our results and 
change the display options. 
  
1. Right click on the Metrics button to reload data from previous analysis runs 
2. Select "Illuminance Values" from the "Lighting Test" drop down menu 
3. Browse to the ".dat" file from the illuminace test we just ran. It will be located in the folder "Gund_111-
Results" and will be named, "Gund_111.clsky092109.dat" 
4. Change some of the display options in the Load Metrics dialog box 
5. Click Load Simulation Data 
 

Archiving Results 

Keeping track of multiple tests 
Let's say you want to run tests for the equinoxes and the solstices at 9am, 12pm and 3pm. DIVA will 
automatically track these options in the results file name, so you don't have to remember which file was run 
with which date, time or sky condition. In addition, say you ran one test, and wanted to run it again (for 
whatever reason). The files won't be overwritten. Instead, a new result file will be created with an appended 
index number: "01, 02, 03, etc.". 
 
 
Suggested file organization methods 
If you are testing out a single model with model-based variants such as materials or geometries, consider 
saving a separate Rhino file for each variant, with a name that identifies it by the variant. That way, when you 
run DIVA, a separate results folder will be created for each variant. If you don't do this, then all of the variants 
will be stored in the same results folder and it will be harder to tell which file contains the results from which 
variant. 
 
 
On the other hand, if you are testing out times of day, or different metrics, or sky conditions, these can all be 
easily stored using the same results folder and file names since the automatically-generated DIVA extensions 
will keep track of that information. 
 

Troubleshooting 

If you are having problems with installation and you are working in a firewalled environment, see 
the alternate installation instructions. 
 
 
1. Geometry does not appear to be included in the Radiance analysis 
Possible reasons: 
 If you are running Rhino 5, did you adjust the default .obj export settings? 
 Is the missing geometry on a layer that is locked or off? 
 Is the missing geometry is on a layer which does not have a material assigned? 
 Is the geometry is complicated? Has the geometric density been set high enough? (in the Metrics dialog 

box) 
 Are the surface normals oriented correctly? Check using the "Dir" command in Rhino. 

 
 
Check if the geometry is exporting properly by running the Visualization/Image Metric and see whether the 
geometry appears properly in the rendering. It is generally a good idea to use a visualization to visually verify if 
your geometry is exporting properly before running any of the metrics. 
 
 



2. Results seem incorrect 
Possible reasons: 
 Your geometry is not exporting properly. Run a Visualization Metric to verify. 
 Your Radiance parameters are not set high enough. Try increasing them in the Metrics dialog box. 
 Your sensor node normals are not oriented properly. Check them using the "Dir" command in Rhino. 
 You have not created a ground plane and/or you have not assigned it a material. Ground planes should 

always be added into models, and be assigned a material.\ 
 Results can be surprising, but always gauge them against what you would expect. 

 
 
3. Nodes appear on the wrong side of the plane 
The surface normal of the drive surface is reversed. Use the "Dir" command in Rhino to reverse the normals of 
the plane to which the nodes are associated. 
 
 
4. "Rtrace – warning no lights found" 
You can ignore this warning. It indicates that no sources other than the sun are found in the scene. Similarly, 
when running the “Radiation Maps” metric, there is a series of lines which say “ERROR!”. This can be 
disregarded as well. 
 
 

 
 
 
5. Various odd problems 
Is your Rhino installed as a non-English localization? Unfortunately DIVA has some issues with non-English 
command parameters. You can add English by following the instructions 
at http://wiki.mcneel.com/rhino/addlanguages 
 
You can then switch back and forth by going to Tools > Options :: Rhino Options > Appearance > Language 
 
 
6. Error message in German when running a Visualization 
It is likely that the view you are rendering is set to parallel projection. In order to produce an image, the 
projection must be set to perspective. Change it by going to the "Properties" panel and select "Perspective" 
from the Projection drop down menu. 



Simulations in General 

In the Metrics dialog box, there are many options which are common to two or more simulation types. Since 
these are common to several simulation types, we will review them all in one place (this page). 
  
These options include: 

 Quality Preset and Radiance Parameters 
 Sky Condition 
 Date and Time 
 Hide Dynamic Shading 
 Geometric Density 

and for Image-based simulations: 
 Camera Type 
 Camera Views 
 Generate .tiff 
 Open With 
 Image Size 



 
 DIVA Simulation Menu 

 
 
Image Quality and Radiance Parameters 
(Low, Medium, High (Long Render Times)) 
Each quality preset relates to a set of Radiance parameters which can be seen and edited in the "Advanced 
Parameters" section of the dialog box. These settings set things like the number bounces and the number of 
rays that the Radiance engine will calculate for the simulation. It is not advisable to manually change these 
settings unless you have first understood the various Radiance commands and their respective values. For 
more information, see: Radiance Manual 
 
 



Make sure that you follow the conventions for specifying variables (e.g. "-ab", not "ab"). 
 
 
For quick tests, the Low preset is fine, but for good, reliable results the High Preset is recommended. The 
Medium setting can be a good option for simulations that could possibly run extremely long if set to "High". 
Since many Radiance simulations involve a stochastic process, re-running the exact same simulation can 
produce slightly different results each time. Higher resolution settings will reduce the variability in results, but at 
the expense of longer simulation times. 
 
Sky Condition 
(Clear Sky, Overcast Sky, Custom Sky, Clear sky without sun, Uniform 
 
 
 
You can specify a number of different sky conditions for your scene as explained below. The most common 
options typically used are Sunny or Cloudy. 

 Sunny Sky: Uses the Radiance program gensky to model a CIE clear sky. This is a standard file 
defined by the International Commission on Lighting (CIE). 
 

 Cloudy Sky: Uses the Radiance program gensky to model a CIE overcast sky. This is a standard 
file defined by the International Commission on Lighting (CIE). It is bright near the zenith and 
rotationally invariant, meaning that it looks the same in all orientations. This is the reference sky for 
the daylight factor. 

 Custom Sky: In case you are interested in modeling a particular sky,for example when you have 
taking illuminance measurements of a space and you would like to model the space now under the 
same daylighting conditions. you can use the Perez sky model (Radiance program gendaylit) which 
requires as input date and time as well as measured direct and diffuse horizontal irradiances. 

 Clear sky without sun: Same as clear sky but without  the solar disk. Some designers like using this 
theoretical (non physical) sky to distinguish between lighting contributions from  the celestial 
hemisphere and from direct sunlight. 
 

 Uniform: Uses the Radiance program gensky to model a completely uniform sky.The underlying 
uniform sky model was used before the CIE overcast and other sky models were introduced. 
 

 
 
 
 
Date and Time 
(mm dd hr) 
The solar date and time are set by specifying month, day and hour in the format: mm dd hr (a single space 
between each entry). For instance: December 10 at 3:15pm would be: 12 10 15.25. 
Solar Date and Time mean that the sun position is calculate taking the Equation of Time into account, and 
WITHOUT daylight savings time. 
 
 
Hide Dynamic Shading 
(checkbox) 
If selected any Rhino layer that is modeled as a dynamic shading systems such as a lowered venetian blind is 
excluded from all calculations except for climate-based metrics and electric lighting simulations. 
 
 
 
Geometric Density 
(0-100) 
To use a finer mesh resolution when running any of the Metrics, adjust the “Geometric Density” option. Values 



range between 0 and 100. “0” represents the crudest resolution of curves and complicated surfaces, where as 
“100” produces the most refined resolution. 
 
 
Camera Type 
(Perspective, 180 degree fisheye) 
DIVA Image simulations will only successfully run when the projection of the view you want to run is set to 
"Perspective Projection" in Rhino. If your view is set to an Orthographic Projection, an error will appear. To 
change the projection of your view in Rhino. Make sure that nothing is selected, and navigate to the 
"Properties" menu. Under "Viewport", there is an option which says "Projection". You can change the setting 
there. 
The 180 degree fisheye automatically set when the Run Evalglare check box is checked. 
 
 
Camera Views 
(Current Perspective View, Saved views only) 
By default, when running an Image simulation, DIVA will render the current view in Rhino. The "Saved Views 
Only" option allows you to run only the views you have saved under "Named Views" in Rhino. With either 
choice, remember to make sure they have a Perspective projection. 
 
 
Generate .tiff 
(checkbox) 
Image simulations automatically create a *.pic file which is effectively, an *.hdr (high-dynamic range) image. 
Unfortunately, these images cannot be opened by most photo previewers and NOT by Photoshop. In the 
wxfalsecolor window, you have the option to save the file that is generated as several file types, including a 
jpeg, but checking the "Generate .tiff" dialog box will save you the extra step of saving the image and will 
automatically generate and store the image as both a *.pic and *.tif in your results folder. 
 
 
Open With 
(wxfalsecolor, Radiance IV, Do Not Open) 
wxfalsecolor is a program developed by Thomas Bleicher and is automatically installed with DIVA. In order to 
use the Radiance IV option, you must have the Radiance Image Viewer installed on your computer. 
 
 
Image Size 
(integer integer) 
The dimensions of your output image can be set here. Values are entered in pixels x pixels in the format: 
integer integer. For instance 640 x 480 would be entered as: 640 480. 
Cleanup Temporary Directory 
(checkbox) 
Selecting this option will automatically clean up unnecessary files from the C:\DIVA\Temp\[RhinoFilename] 
directory. 

 

 

 

 

 

 



Simulation Categories 

When you click on the Metrics button, at the top of the menu that pops up are tabs with the 3 simulation 
category types. The tab names are: Daylight Images, Daylight Grid-Based and Thermal Single-Zone. These 
are described below. 
 
 

Simulation Categories: DIVA 
Metrics Menu Tabs 

 
 

Daylight Images 
(Visualization, Timelapse, Radiation Map, Point-in-Time Glare, Annual Glare) 
This category contains all metrics for which the output is an image in the format of *.pic which can also be 
saved as a .tif or various other image types, and can be viewed in an image viewer like wxfalsecolor. The 
images do not depend on nodes, and do not output to a falsecolor grid. 
 
Daylight Grid-Based 
(Daylight Factor, Point-in-Time Illuminance, Climate-Based, Radiation Map) 
 
These simulations depend on the setting up of the sensor node grid, using the Nodes button. The output of 
these simulations is a falsecolor grid which shows up directly in the Rhino, and can be exported in the ways 
that other Rhino views can be rendered, printed or exported.  
 
Thermal Single-Zone 
 

Visualization 

Metrics  >> Daylight Images >> Visualization 
The Visualization simulation creates a Radiance rendering (*.pic) of the selected Rhino view of your model. 
This is a useful simulation to run before all other simulations, because it provides very useful information as 
to whether your model geometry is defined correctly and properly exporting. Sometimes surface normals are 
flipped, geometry is turned off or has not been defined a material, or other inconsistencies occur. The visual 
check allows you to preview the model the way Radiance sees it before running your simulation. Make sure 
your selected viewport is a perspective view and not an orthographic projection(Front, Top, etc...). 
 
 



 
 

 

 

 

 

 

 



Radiation Maps 

Example of a 
radiation map generated in DIVA using rpict and gencumulativesky  

  
DIVA-for-Rhino can generate climate-specific annual surface irradiation images or calculate 
annual irradiation at node locations. This is a powerful tool that can be used on an urban or building scale to 
identify locations with solar energy conversion potential or areas in need of shading due to excessive solar 
exposure. Comparing summer and winter period irradiation results could help optimize shading devices to 
maximize winter gain while minimizing summer exposure. 
 
 
The analysis uses a method described by Robinson and Stone which harnesses a Radiance module called 
GenCumulativeSky to create a continuous cumultaive sky radiance distribution. This cumulative sky is then 
used in a Radiance backwards ray-trace simulation. Compared to other approaches which use hourly 
calculations, this approach is significantly faster with a minimal sacrifice in accuracy. 
 

 

 

 

 

 

 

 

 

 

 



Daylight Factor and Illuminance  

Daylight Factor 
Metrics >> Daylight Grid Based >> Daylight Factor 
A daylight factor is the ratio between exterior sky illuminance on an overcast day and illuminance inside a 
building. To run the metric, you must have first set up a sensor node grid using the Nodes button. 
 
 

Metrics Menu: Daylight Factor 
 
 

Since the sky condition is overcast, neither a sky condition nor a date and time for the calculation are needed. 
You have the option to manually change your Radiance parameters and the geometric density of your 
geometry. 
 
 
Illuminance 
Metrics >> Daylight Grid Based >> Point-in-Time Illuminance 
Illuminance calculations are also called "point-in-time" calculations because unlike the annual, or climate-
based metrics, illuminance calculations measure light levels at a specific date and time. Like Daylight Factor, 
you will need to set up the sensor node grid, using the Nodes button before you run this metric. 
 
 



Metrics Menu: Point-in-Time 
Illuminance 

 
Units 
(Lux, Footcandles) 
Select your preferred lighting units 
 
 
Solar Date and Time 
(mm dd tt) 
Enter a date and time for the calculation. To enter minutes use an integer followed by a decimal point. For 
example, if you want to run a test on September 21 at 9:15am. Enter "09 21 9.25". 
 

Climate Based Metrics 

 

Daylight Autonomy, Continuous Daylight Autonomy, Daylight Availability, Useful Daylight Illuminance 
Metrics >> Daylight Grid Based >> Climate-Based 
 
 
Climate-Based Metrics use recorded climate data in the form of *.epw files to simulate the sun and sky 
conditions for various simulations including Daylight Autonomy, Daylight Availability, Continuous Daylight 
Autonomy and Useful Daylight Illuminance. The second important aspect of Climate-Based Metrics is that they 
are annual calculations which means they take the entire year into account. The metrics use Radiance and 
Daysim as their calculation engines. 
 
 



Metrics Menu: Climate-Based 
 

 
 
Units 
(Lux, Footcandles) 
Although Radiance and Daysim only use lux as a unit of illuminance, if you are working in and environment 
which reference footcandles, you select "Footcandles" as a unit here. The values will be converted over to lux 
in the simulation process and then back to footcandles for the display output. 
 
 
Occupancy Schedule 
(always_occupied.60min.occ.csv, never_occupied.60min.occ.csv, weekdays9to5withDST.60min.csv) 
In this dialogue annual hourly occupancy schedules can be selected. These occupancy schedules are used to 
determine when a lighting or shading group is occupied. These files are stored in csv (comma seperated value) 
format under c:\DIVA\Schedules. 
 
 
Target Illuminance 
(integer) 
Select a target illuminance level for your space. This level should depend on space type for example 500 lux of 
an office. For predominantly daylit spaces it has become customary to assume a target illuminance of 300 lux. 
  
 
Show Daysim Report 
(checkbox) 
 If selected a detailed Daysim report will be displayed in your browser. 
 
 
 
Adaptive Comfort 
(User(s) cannot adapt. Simulation uses viewpoint with worst glare condition., User can adapt. Simulation uses 
least glary viewpoint.) 



This parameter determines how annual glare simulations inform the use of a dynamic shading system. If the 
shading system is manual controlled and more than one view point was provided for the annual glare 
calculation, then the former selection assumes that a user can adapt to the space and pick the position with the 
least amount of glare. In the latter case several occupants are in the space and the occupant with the worst 
glare condition determines whether the shading device needs to be readjusted. 
 

Load Metrics 

To load previous results into your model, you right-click on the Metrics button. The Choose and Load 
Metrics boxes are displayed. The Load Metrics box is also displayed when any of the node-based metrics are 
finished running. The boxes provide options for how the results are displayed, and depend on which metric you 
are loading. 

Choose metrics dialog 
Lighting Test prompts you to choose which metric to load. Most of these are self-explanatory; however, 
'Illuminance from DA' is a new feature which allows visualization of the hourly illuminance results from Daysim / 
Climate-based metrics. 
Choose Select Metric to Load if loading a grid-based result. 
Choosing Climate-Based Falsecolor will allow an hourly temporal map of climate-based simulation results for 
a selected point. 

A result of the climate-based falsecolor option 



Load metrics dialog 
 
 
Min/Max Illuminance (Illuminance and Continuous Daylight Autonomy) 
(integer, integer) 
The user can set the lower and upper bounds which correspond to the colors displayed on the false-color node 
grid. 



 
 
Min/Max Irradiance (Radiation Nodes) 
(integer, integer) 
The user can set the lower and upper bounds which correspond to the colors displayed on the false-color node 
grid. 
 
 
Min/Max Daylight Factor (Daylight Factor) 
(integer, integer) 
The user can set the lower and upper bounds which correspond to the colors displayed on the false-color node 
grid. 
 
 
Color Scheme (All Metrics) 
(3 gradient options) 
This option lets the user select which color scheme to use for the false-color node grid. 
 
 
Label 1% Peak Nodes (All Metrics) 
(checkbox) 
By checking this box, the 1% peak nodes will be highlighted. 
 
 
Label All Nodes (All Metrics) 
(checkbox) 
Checking this box will display the numeric result value at each node. These node labels are stored on their 
own DIVA sublayer called, "Node Values". 
 
 
Color Extreme Values (Daylight Factor, Illuminance, Radiation Nodes, Continuous Daylight Autonomy) 
(checkbox) 
Panels whose values fall below the set range are shaded black and those that fall above are shaded bright 
pink. 
 
 
Display Footcandles (Illuminance, Continuous Daylight Autonomy, Useful Daylight Illuminance, Daylight 
Autonomy, Daylight Availability) 
(checkbox) 
This should be checked if the user selected "footcandles" as the "Lighting Units" in the Metrics dialog box 
before running the metric. 
 
 
Create Variant Label (All metrics) 
(text) 
In this space the user can enter a "variant" label (or title) for the calculation. This helps in remembering key 
options that were being tested during the metric. 
 

Understanding DIVA Results Files 

DIVA Grid-Based Results 
 
When you run a DIVA simulation, a directory of files is created for you, and depending on the metric you run, 
different file types will be created. For Daylight Grid-Based Simulations these files are basic text files with 
different file extensions.  In this tutorial, we are going to take a look at the results files for Daylight Factor, 



Point-in-Time Illuminance, Climate-Based Metrics and Radiation Maps and learn what information they contain 
and how to use them to learn more about your analysis. 
The two basic file types (file extensions) for the Daylight Grid-Based simulations are *.dat and *.da:  
.dat files 
Daylight Factor                                   *.df.dat 
Radiation Maps                                 *_ radmap.*.dat 
Point-in-Time Illumiannce               *.dat 
.da files 
Daylight Autonomy                            *_autonomy.shading.da 
Daylight Availability                           *_availability.shading.da 
Continuous Daylight Autonomy      *.shading.cda 
Useful Daylight Illuminance            *_UDI_100.shading.da, *_UDI_100_2000.da, *_UDI_2000.da 
Viewing Grid-Based Results 
These files can be easily viewed in any basic text editor, such as Text Pad, or they can be imported into 
spreadsheet programs, like Excel, for analysis. First, let’s look at how we would import a .dat file into Excel. 

DIVA Results Directory 
  

 
Opening files with Text Pad 

  
Step 1           Run a Point-in-Time Illuminance metric and locate the results file 
Step 2           Click FileàOpen 
Step 3           Change “File Type” to “All Files” 
Step 4           Browse to your results folder 
Step 5           Select the .da or .dat file that you want to open 
Step 6           Use the screen shots below to guide the rest of the import 



Step 3 Select "All Files" as the 
file type 

  

 
Step 5 Select a .dat file to open 

  

 
Step 6a Select "Tab" and "Space as delimiters 

  



 
Step 6b Click "Finish" 

  
  

Understanding Grid-Based Results  
When you open any of these files, some parts are the same regardless of which file you look at.  All .DA files 
will have some basic information at the top which identify the name of the metric, and some basic information 
such as the design illuminance threshold. The other information common to all files is a series of lines at the 
end of the file, all preceded by “#”. There is one set of these lines for each set of nodes in your model (a 
nodegroup is the group of nodes associated with one surface in your model). For the most part, you don’t need 
this information. It is primarily used by DIVA for loading in files. 

Node Values Displayed 
  



 
.dat file in Excel 

  

 
.da file in Excel 

  



 
.dat file data 

  
The important part of the files is the middle section. Regardless of the results file, each line contains 
information for one of the sensor nodes in your model. The first three numbers of each line are the x, y and z 
coordinates of a given sensor node. For the all of the .dat files, there are a second set of three numbers which 
are the x, y, and z components of the node vector (this gives the node orientation). 
  
The last numbers are the metric value for the associated node. For the .dat files there are three numbers which 
are the R, G and B components of the Daylight Factor, Irradiation, and Illuminance. In the file they are in this 
order: R-value, G-value, B-value. You may notice that none of the columns contain values that equal the node 
values displayed by the same file in the model. These three values represent a weighted contribution to the 
final Daylight Factor, Irradiation or Illuminance value. To derive that result, a factor is placed on each 
component and the weighted values are summed. 
For the Daylight Factor and Radiation Maps metrics, this equation is: R*0.265 + G*0.67 + B*0.065, where R, G 
and B are the R, G, B values from the last three columns of the results file. For the Illuminance metrics, the 
equation remains the same, but the entire sum is multiplied by 179: (R*0.265 + G*0.67 + B*0.065)*179. For the 
.da files, there is just one number after the sensor node coordinates which is the DA value. No additional steps 
are necessary to derive a final answer. 
Once you have your values in place, you can Excel’s functions and graphing capability to analyze your results 
in hundreds of ways. 
 
 


